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Welcome

Apple Learning Series: Secondary Language Arts & Social Studies provides you with
materials to help you easily integrate technology into your classroom. This Getting
Started Guide describes the contents of this kit, what you need to do before you use
the software, and how to install and begin using the software.

Secondary Language Arts & Social Studies contains the following items:
» Secondary Language Arts & Social Studies CD software case

= Resources on the Secondary Language Arts & Social Studies Web site
m Quick Start card

Secondary Language Arts & Social Studies
CD software case

The CD software case contains all of the software for Secondary Language Arts &
Social Studies. Most products include electronic documentation on the CD, such as
user’s manuals or teacher’s guides.

Note: If you purchased this kit with a new iMac computer, you have received
additional software CDs, such as AppleWorks. The specific CDs included may vary
depending on the model of iMac. The curriculum materials include the use of some
of these CDs. If you do not have a product used in the student projects, you can
substitute another CD of the same type. For example, you can use a different
encyclopedia CD for World Book Encyclopedia or another Web page editor for
Adobe PageMill, such as Netscape Composer which is included on the iMac.

Web site contents

The Secondary Language Arts & Social Studies Web site includes the following
components:

Curriculum

The Web site includes student projects for both the middle school level and for the
high school level. Each project provides ideas for integrating the kit software in your
classroom. You can view the student projects online or print them from the Web site.
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Read the middle school and high school Curriculum Overviews on the Web site for
detailed information about the contents and structure of the student projects and the
other curriculum resources.

Step-by-step instructions

Step-by-step instructions for tasks that involve using the kit software and Apple
technology are included on the Web site. These detailed instructions are designed to
help your students work independently to complete software-related activities. You
can download and print the files. You need the Acrobat Reader program installed on
your computer to view and print the Step-by-Step Cards. (See “Installing Acrobat
Reader” later in this guide.) After you print them, you can laminate them for
durability and keep them near the computer.

Resources

Electronic templates are provided to help you and your students complete some of
the activities in the projects. You can use these files as is or you can customize them
for your classroom needs. You can download these templates from the Web site. The
Resources area of the Web site also includes relevant QuickTime movies and
documents that can help you use the templates and projects.

From the Secondary Language Arts & Social Studies Web site, you can also access the
Web Page Construction Site, a collection of instructions and other resources to help
you create your own Web pages. You can download this site and use it as a template
for customizing your own instructional Web site. You can then post it on an intranet
or use it in your classroom.

Curriculum standards

The Secondary Language Arts & Social Studies Web site includes correlations
information that shows how the software and student projects align to curriculum
standards. You can search for correlation information by grade level, subject area,
topic, and by select states.

Apple Learning Professional Development online course

Secondary Language Arts & Social Studies includes an online course that is designed
to help you learn how to use the kit software to enhance the curriculum in your
classroom. You can access this course from the Secondary Language Arts & Social
Studies Web site by clicking the Professional Development button.

The course introduces each of the software products, presents a brief demonstration
of an aspect of the software, and describes how the software can be applied in your
classroom.
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Community

This area of the Web site includes forums where you can discuss the Secondary
Language Arts & Social Studies kit and its online course; additional student projects,
submitted by other teachers, that use the kit software; and teachers’ reviews of the
software. You can also access the extensive resources of Apple Learning Interchange
(ALI), the Apple online community for educators. ALI offers forums, chat rooms,
lesson plans submitted by teachers, special events, and other resources.
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First Steps

Several preliminary steps should be taken before you begin using the software in
Secondary Language Arts & Social Studies. These steps are described in “Before You
Use the Software,” below. You should also become familiar with Adobe™ Acrobat™
Reader, the program you will use to read most of the electronic documentation in
this kit and to read many of the files you download from the Secondary Language
Arts & Social Studies Web site. See “Using Acrobat Reader,” later in this section, for
detailed instructions about using this program.

Before you use the software

Before you begin to use the software, you need to select a printer, make sure that the

correct version of QuickTime is installed, and make sure that Acrobat Reader is
installed.

Note: If you are using the student projects with an iBook or Power Mac G4
computer, you will need a compatible external microphone (available separately) to
complete the activities that involve recording sound.

Select a printer

Some programs in the kit require you to have a printer selected, even if your
computer is not connected to a printer. If you have not already selected a printer,
follow these steps to do so:

Open the Apple () menu and choose Chooser.

In the upper-left section of the Chooser window, click to select the printer driver
that corresponds to the kind of printer you want to use.

Note: If your computer is not connected to a printer, select the LaserWriter 8 icon;
then click the close box to close the Chooser. You don’t have to do steps 3 and 4.

In the upper-right section of the window, do one of the following:

» Ifyou are connected to a network, click to select the name of the printer you
want to print to.

» Ifyou are not connected to a network, click to select the printer port or modem
port, whichever port your printer is connected to.
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Click the close box to close the Chooser window.

For more information on setting printer options, see the manual that came with
your printer.

Installing QuickTime

To use some of the software in the kit, you need QuickTime 4.0 or later installed on
your computer. To install the latest version of QuickTime, go to the Apple Web site at
www.apple.com/quicktime/ and follow the onscreen instructions. To check the
version of QuickTime that is installed on your computer, choose Control Panels from
the Apple menu, then choose Extensions Manager from the submenu. Scroll to
QuickTime in the list below Extensions. The version number is displayed.

Installing Acrobat Reader

Most of the electronic documentation included on the software CDs and many of the
files you download from the kit's Web pages are in Adobe Acrobat format, also called
“PDF” format. To view and print these files, you need the Adobe Acrobat Reader
program. In some versions of the system software, Acrobat Reader is preinstalled on
your computer in the Applications folder.

If you purchased Secondary Language Arts & Social Studies without a computer, you
need to check to see if the latest version of Acrobat Reader is installed on your
computer. You can find out the version number of the Acrobat Reader program
installed on your computer by selecting the Acrobat Reader program icon, then
choosing Get Info from the File menu. The version number is displayed. You can find
out the latest version number by going to the Adobe Web site at www.adobe.com. If
the latest version is not already installed, you can download the new Installer
program for free from the Adobe Web site.

Using Acrobat Reader

With Acrobat Reader, you can easily move around the documentation, search for
specific words or phrases, change the size of a page, and print any pages you want to
have as hard copy.

Moving through a document

You can move through a document in a number of different ways:

= To o to the next page, click the Next Page button ([®]) on the toolbar.
w To return to the previous page, click the Previous Page button ([4).

w To return to the first page, click the First Page button ([4]).

» To go to a specific page, click the page number box on the status bar at the
bottom of the main window, type the page number, and click OK.

= To search for a specific word, phrase, or activity, click the binoculars button ([#])
on the toolbar, type the information you are searching for, and click Find.
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For more information about moving around in Acrobat Reader documents, see
“Navigating pages,” in the “Viewing PDF documents” section of the Acrobat Reader
electronic help system.

Changing the size of a page

To magnify or reduce the size of a page, click the box with the magnifying glass ([&])
on the status bar at the bottom of the page; then select a magnification level. Refer to
“Viewing documents” in the “Viewing PDF documents” section of the Acrobat Reader
electronic help system for detailed information on other page display tools and
options.

Printing pages

You can print any pages of a PDF document while in the Acrobat Reader program.

To print specific pages using most printers, follow these steps:

Choose Print from the File menu.

Enter the page numbers as they appear at the bottom of the Acrobat Reader window.
These numbers may differ from the numbers that actually appear on the document
itself.

Click Print.

Using the Acrobat Reader electronic help system

For more information about using Acrobat Reader, see the program’s electronic help
system. To use the help system, choose Reader Online Guide from the Help menu;
then select the topic you want. Click “How to use this online guide” from the list at
the left of the main page to learn more about using the help system.
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Software Descriptions
and Installation Instructions

The CD software case contains all of the software titles included with Secondary
Language Arts & Social Studies.

The following sections provide a brief description of each software product,
information on installing and opening the program, and ways to learn more about
it. Use these instructions, rather than the instructions that may be in the product’s
electronic manual or Read Me file. For most of the software products, you'll find a
technical support phone number. (The phone numbers listed in this section were
current at the time the guide was written. However, this information is subject to
change.)

Note: Do not install any version of QuickTime or Acrobat Reader that might be
included on a product’s CD. The product CDs sometimes include older versions of
QuickTime or Acrobat Reader. If you install an older version of QuickTime you may
have problems using the software; an older version of Acrobat Reader might prevent
you from opening electronic documentation or files you download from the
Secondary Language Arts & Social Studies Web site.

If you install an older version of QuickTime or Acrobat Reader by mistake, you can
easily reinstall the current version. To install the latest version of QuickTime, go to
the Apple Web site at www.apple.com/quicktime/ and follow the onscreen
instructions. (After installation, you should make sure that the older version of
QuickTime is no longer on your hard disk.) To install the latest version of Acrobat
Reader, go to the Adobe Web site at www.adobe.com and follow those instructions.
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Chronicle of the 20th Century from DK Multimedia

This interactive guide to the major events, personalities, and places of the 20th
century combines photographs, sound, video, and articles. You can read about events
as they occurred month-by-month, and view a news entry for each day in the century.
Eight in-depth, interactive overviews about important events are also included as well
as biographies of 100 influential individuals. You can search for information by word,
date, or media.

Installing Chronicle of the 20th Century

Insert the Chronicle of the 20th Century CD into the computer’s CD or DVD drive.
Double-click the DK Chronicle CD icon, if necessary.

Drag the Chronicle of the 20th Century folder to your hard disk icon.

You'll still need the CD to use Chronicle of the 20th Century because not all the files
from the CD have been installed on your computer.

Using Chronicle of the 20th Century

Before you use Chronicle of the 20th Century, you need to make sure that virtual
memory is turned on. To do so, follow these steps:

Choose Control Panels from the Apple menu; then choose Memory.
If the On button is not selected under Virtual Memory, click to select it.

Choose Restart from the Special menu to restart your computer if you turned on
virtual memory in step 2.

To open Chronicle of the 20th Century, follow these steps:
Make sure the CD s still in the computer’s CD or DVD drive.
Open the Chronicle of the 20th Century folder on your hard disk.

Double-click the Chronicle of the 20th Century icon to open the program.
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Learning more about Chronicle of the 20th Century

A teacher’s guide is included on the CD. Double-click the ChronC20.pdf icon to open
the teacher’s guide.

Chronicle of the 20th Century also includes an electronic help system. To use the
help system, follow these steps:

Click the Navigator icon (the oval with four arrows) at the top-left corner of the
screen.

A navigation bar appears.

Click Help from the right side of the navigation bar.

Click a topic from the help contents list to see information about that subject.
When you're done using the help system, click the main screen.

Chronicle of the 20th Century includes an Internet magazine feature, Chronicle
Online, that offers additional resources for those who have an Internet connection.
To access the Web site from the CD, click the Navigator button at the upper left of the
screen; then click Chronicle Online. Refer to the Read Me document in the CD
window for more information. You can also access the Chronicle Online Web site
directly at: www.dkonline.com/chronicle.

The service and support telephone number for Chronicle of the 20th Century is
800-356-6575.
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Decisions, Decisions: Colonization
from Tom Snyder Productions

In this CD from the Decisions, Decisions series, students work in teams to role-play a
president of the United States who must decide whether to allow a private company
to set up a U.S. colony in space to search for fuel deposits. Because the issues are the
same as those faced by the original colonizers of the United States, students study the
history of U.S. colonization and apply what they learn to the current situation.
Students follow a five-step model for critical thinking and decision making to gather
and analyze information, discuss and debate their choices, take action, and evaluate
their decision.

Using Decisions, Decisions: Colonization

You use Decisions, Decisions: Colonization directly from the CD. To open the
program, follow these steps:

Insert the Decisions, Decisions: Colonization CD into the computer’s CD or
DVD drive.

Double-click the Decisions, Decisions CD icon, if necessary.
Double-click the Colonization icon to open the program.

You can select Overview from the Decisions, Decisions: Colonization main menu to
see a narrated introduction to how Decisions, Decisions titles are used in the
classroom.

Learning more about Decisions, Decisions: Colonization

A teacher’s guide is included in the Teacher’s Guide folder. Double-click the
Colonization TG.pdf file icon to open the teacher’s guide.

Files for four student booklets (“briefing books” for the president from an economist,
an historian, the Secretary of Commerce, and the Secretary of Space Exploration) are
included on the CD in the Student Books folder. You can print these booklets and
distribute them to the students, or you can order the booklets in printed form by
calling 800-342-0236.

Decisions, Decisions: Colonization also includes an electronic help system. To use the
help system, follow these steps:

Choose Decisions Help from the Help menu.
Click to select Topics, Index, or Look For to find the information you want.
When you're done using the help system, click the help window close box.

You can also see information about the current screen by clicking the Guide button
in the lower-right corner of the screen.

The service and support number for Decisions, Decisions: Colonization is
800-342-0236, extension 255.
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Eyewitness History of the World from DK Multimedia

Eyewitness History of the World is a multimedia encyclopedia that lets students visit
different civilizations, witness historical events, and meet key people who shaped
history. It includes video sequences and animations, a Quiz Master feature, and
information on everyday life, culture, and innovations throughout history. The
contents in this encyclopedia can be copied for use in other applications.

Installing Eyewitness History of the World

You can use Eyewitness History of the World directly from the CD, or you can install
it on your hard disk for improved performance. To install Eyewitness History of the
World on your hard disk, follow these steps:

Insert the Eyewitness History of the World CD into the computer’s CD or DVD drive.
Double-click the Eyewitness History CD icon, if necessary.
Drag the folder called “Eyewitness History f” to your hard disk icon.

You'll still need the CD to use Eyewitness History of the World because not all the
files from the CD have been installed on your computer.

Note: Do not install the files located in the System Software folder on the CD.
Current versions of those files are already installed on your computer.
Using Eyewitness History of the World

Before you use Eyewitness History of the World, you need to make sure that virtual
memory is turned on. To do so, follow these steps:

Choose Control Panels from the Apple menu; then choose Memory.
If the On button is not selected under Virtual Memory, click to select it.

Choose Restart from the Special menu to restart your computer if you turned on
virtual memory in step 2.

To open Eyewitness History of the World, follow these steps:
Make sure the CD s still in the CD or DVD drive.

Double-click the Eyewitness History of the World application icon to open the
program. If you installed the program on your hard disk, the icon is in the
“Eyewitness History f” folder. If you're using the program directly from the CD, the
icon is in the Eyewitness History CD window.

Secondary Language Arts & Social Studies Getting Started Guide



Learning more about Eyewitness History of the World

Eyewitness History of the World includes a teacher’s guide. Double-click the
History.pdf icon on the CD to open the teacher’s guide.

Eyewitness History of the World also includes an electronic help system. To use the
help system, follow these steps:

Click the question mark button at the left side of the screen.
Click a topic to see information on that subject.
When you're done using the help system, click the main Eyewitness History screen.

The service and support telephone number for Eyewitness History of the World is
800-356-0575.
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HyperStudio from Knowledge Adventure

HyperStudio is multimedia authoring software that you and your students can use to
create projects and presentations that include text, pictures, movies, animation, and
sound. HyperStudio also gives users the ability to import and edit multimedia
resources, such as graphics and QuickTime movies.

Installing HyperStudio

Insert the HyperStudio CD into the computer’s CD or DVD drive.

Double-click the HyperStudio CD icon, if necessary.

Open the “Installer in here!” folder.

Double-click the HyperStudio Installer icon.

In the screen that appears, click Continue.

Click Accept in the software license screen.

Click Install in the next dialog box.

When you see a message stating that installation was successful, click Continue.
(You do not need to enter your registration number to use HyperStudio, so do not
be concerned if you see a message stating that you will need a registration number.)

The HyperStudio main screen appears.

The basic files you need to use HyperStudio are placed on your hard disk in a folder
called “HyperStudio for HD.” Files related to the Internet are in a folder called

HS Internet. You should also keep your HyperStudio CD nearby because it contains
a media library that you might want to use as you develop your own projects.

Using HyperStudio

Once you have installed HyperStudio, follow these steps to open the program in the
future:

Open the “HyperStudio for HD” folder on your hard disk.

Double-click the HyperStudio 3.3 icon to open the program. (You may need to scroll
down to locate the icon.)

Note: When you import QuickTime movies from resource CDs into your projects,
make sure that the movie file resides in the same folder as your multimedia project. If
the movie file is not in the same folder as your project, you will need to reinsert the
CD each time you open your HyperStudio project.
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Learning more about HyperStudio

HyperStudio includes the following electronic documentation in Adobe Acrobat
format: a quickstart guide, a reference manual, two manual supplements, and a
tutorial. You can use the quickstart guide or the tutorial to complete a sample
HyperStudio project about France. The tutorial also contains basic information about
using HyperStudio. The reference manual and the supplement to the manual detail
the program’s features. A reference manual and a tutorial for the HyperStudio
scripting language, HyperLogo, are also included.

To open the electronic documentation, first open the “HyperStudio for HD” folder on
your hard disk; then double-click the folder named HS Manuals. Double-click the
icon for the document you want to read:

» QSGuide.pdf for the quickstart guide

» Mac3x Reference.pdf for the HyperStudio reference manual

» Mac3.1 Addendum.pdf for the version 3.1 reference manual supplement
» Mac3.2 Addendum.pdf for the version 3.2 reference manual supplement
» Mac3x Tutorial pdf for the HyperStudio tutorial

» HIRefnc.pdf for the HyperLogo reference manual

» HLTutor.pdf for the HyperLogo tutorial

When you open HyperStudio, you'll find electronic tutorials that teach you how to
use the program. To use the introductory tutorial, follow these steps:

Click Show Me How in the HyperStudio main screen.
Click HyperStudio Step-by-Step.

Click Introduction in the Step-by-Step screen.

Click Tutorial in the Introduction screen.

If you want to purchase a printed version of the HyperStudio reference manual and
the tutorial, contact Knowledge Adventure directly at 800-HYPERSTUDIO.

The service and support telephone number for HyperStudio is 800-556-6141.
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In My Own Voice from Sunburst Technology

This CD examines the subject of identity from a variety of cultural perspectives by
looking at 27 poems written by 9 contemporary American poets. The CD includes
audio recordings of the poets introducing and reading their poems, annotations to
the poems; illustrations, and music. Students can write and record their own poems
with the multimedia word-processing tool and can take notes from anywhere in the
CD with the notepad feature.

Using In My Own Voice

You use In My Own Voice directly from the CD. To use In My Own Voice, follow
these steps:

1 Insert the In My Own Voice CD into the computer’s CD or DVD drive.
Double-click the In My Own Voice CD icon, if necessary.
Double-click the In My Own Voice icon to open the program.
A dialog box appears asking you to open or create a new notepad file.
Click New.

In the dialog box that appears, type a name for your notepad file and select a location
on your hard disk where you want to save it. Click Save.

The program’s main screen appears.

Learning more about In My Own Voice
A teacher’s guide is included on the CD.

In My Own Voice also has an electronic help system. To use the help system, follow
these steps:

1 Click the Help button on the right side of the screen.
Click a topic from the contents list to see more information about that subject.

Use the red arrows on the right side of the help window to scroll through the text.

A O N

Click the help window close box when you're done using the help system.

The service and support telephone number for In My Own Voice is 800-338-3457,
extension 2410.
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Inspiration from Inspiration Software

Inspiration is a versatile program that can be used in all areas of the curriculum. The
program’s diagram features offer you a symbols library and drawing tools to create
“visual maps” of ideas and concepts. You can use the comprehensive outlining
environment to plan and organize reports, Web sites, multimedia presentations, and
other projects. Examples and templates included with the program illustrate a variety
of ways you can use Inspiration in the classroom.

Installing Inspiration

Insert the Inspiration CD into the computer’s CD or DVD drive.

Double-click the Inspiration 6 Install icon in the CD window.

Click Continue in the opening screen.

Click Install in the dialog box that appears.

When you see a message stating that installation was successful, click Quit.

In the dialog box that appears, type your name, school, and the serial number. The
serial number is on a sticker on the CD sleeve. Click OK.

Select how you want to register the product in the next dialog box.
Note: Do not install the version of Acrobat Reader that is included in the Manual

folder on the CD. A later version of this program is already installed on your
computer.

Using Inspiration

Open the Inspiration 6 folder on your hard disk, if necessary.

Click Close in the “Tip of the Day” window when you are done reading it, or click
Next to see more tips.

Learning more about Inspiration

Inspiration includes electronic files for a getting started guide and a user’s manual.
The files for these documents are located in the Manual folder on the CD.

Inspiration also includes an electronic help system. To use the help system, choose
Inspiration Help from the Help menu, then click Help Topics. Choose Quit from the
Help menu when you're done using the help system.

The service and support telephone number for Inspiration is 800-877-4292.
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An Odyssey of Discovery: Skills for Writers
from Pierian Spring Software

Designed to help students build their language skills, An Odyssey of Discovery: Skills
for Writers presents three engaging, easy-to-use activities that can be adjusted for
different levels. With the Gargoyle activity, students find and correct errors in usage,
punctuation, and spelling. With the “Word by Word” vocabulary activity, based on the
Asian tile game Mah Jongg, students match synonyms, antonyms, and analogies. The
Puzzler is designed to teach students poetic form and function.

Using Skills for Writers

You use Skills for Writers directly from the CD. To open the program, follow
these steps:

1 Insert the An Odyssey of Discovery: Skills for Writers CD into the computer’s
CD or DVD drive.

Double-click the Skills for Writers CD icon, if necessary.

Double-click the Skills for Writers icon to open the program.

Learning more about Skills for Writers

Skills for Writers includes a user’s manual located in the Documentation folder on
the CD. (You may need to scroll to locate the file for the manual.)

Skills for Writers also includes the Mentor feature, an electronic help system. Help
information is available when you see a light on a pedestal or within an activity.
To see and hear the help information, follow these steps:

1 Move the pointer to the light. The pointer changes to an “1.”
Click the light to see and hear help information about the current activity.
Click outside the cloud of light when you're done viewing the help information.

The service and support telephone number for An Odyssey of Discovery: Skills for
Writers is 503-222-2044.
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Romeo + Juliet from Stratford Studios

Romeo + Juliet is an engaging resource for students to use in the study of
Shakespeare. The CD includes an original audio performance of the play, more than
00 related “wacky facts” from Dr. Wacko, and a discussion about the play by animated
teenage critics. Five games are designed to help students understand references in
the play and see it in its historical and cultural context. The Studios feature allows
students to cast and costume the play and write the sequel.

Installing Romeo + Juliet

Insert the Romeo + Juliet CD into the computer’s CD or DVD drive.

Double-click the Romeo CD icon, if necessary.

Double-click the R & J Installer icon.

Click Install in the dialog box that appears.

When you see a message stating that installation was successful, click Quit.

You'll still need the CD to use Romeo + Juliet because not all of the files from the
CD have been installed on your computer.

Using Romeo + Juliet

Make sure the CD is still in your computer’s CD or DVD drive.

Open the “Romeo and Juliet” folder on your hard disk.

Double-click the Romeo & Juliet PPC icon to open the program.

Learning more about Romeo + Juliet

A teacher’s guide is included on the CD. Double-click the manual.pdf icon to open
this document.

Romeo + Juliet also has an electronic help system. When you open Romeo + Juliet,
Lester the Jester provides a spoken introduction to the program. To hear other help
information from Lester, follow these steps:

Click the window shade with question marks that appears at the top-left corner of
some screens.

The window shade opens and Lester provides information about the current screen.

If you're done using the help system before Lester finishes speaking, click Lester
again. The window shade is drawn.

The service and support telephone number for Romeo + Juliet is 415-921-8576.
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Timeliner Collection from Tom Snyder Productions

TimeLiner is a tool that allows you to create and modify different kinds of timelines.
You can chronicle broad topics, such as historical events and geological formations,
or examine milestones in students’ lives with daily, weekly, and yearlong timelines.
This CD also includes 17 different collections of completed timelines, among which
are American History, Women in History, Pre- and Ancient History, African-American
History, and History of Exploration.

Using TimelLiner Collection

You use TimeLiner Collection directly from the CD. To open the program, follow
these steps:

1 Insert the TimeLiner Collection CD into the computer’s CD or DVD drive.
Double-click the TimeLiner 4.0 CD icon, if necessary.

Double-click the TimeLiner 4.0 icon to open the program.

2 O N

From the opening screen, you can choose to create a new timeline or open an
existing one. To open an existing timeline, click Open; then locate and select the
timeline you want to open from the dialog box. The timeline collections are in
folders in the TimeLiner 4.0 Data Disks folder. Other folders on the CD contain
sample timelines.

Learning more about TimelLiner Collection

Electronic files for a teacher’s guide, a student activity guide, and an introductory
tutorial are included on the TimeLiner Collection CD in the Documentation folder.
m Teacher’s guide: Double-click the TimeLiner 4.0 Teacher Guide icon.

w Student activity guide: Double-click the Student Activity Guide icon.

» Introductory tutorial: Double-click the TimeLiner WalkThrough icon.

The teacher’s guide contains a comprehensive tutorial as well as additional
information about using the program. The student activity guide includes student
project worksheets and suggestions for student activities and lesson plans. The

introductory tutorial, called TimeLiner WalkThrough, illustrates the basic steps
for creating a timeline.

The service and support telephone number for TimeLiner is 800-342-02306,
extension 255.
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The Writing Trek—Grades 8-10 from Sunburst Technology

The Writing Trek provides interactive language arts projects and writing skills lessons
that are designed to build writing competence and creativity. Students travel around
a fantasy village and can enter six buildings, which contain student projects and a
notebook that guides them through the projects and where they can save their work.
The projects encompass many different types of writing, including science fiction,
news stories, poetry, and speeches. Students also explore the general concepts
involved in each genre, and can use five writing resources, such as an almanac and a
rhyming dictionary.

Installing The Writing Trek

Insert The Writing Trek CD into the computer’s CD or DVD drive.

Double-click the Trek 8-10 I CD icon, if necessary.

Double-click the Writing Trek 8-10 I Install icon.

Click Continue in the title screen.

Click Install in the dialog box that appears.

When you see a message stating that installation was successful, click Quit.

You'll still need the CD to use The Writing Trek because not all of the files from

the CD have been installed on your computer.

Using The Writing Trek

Make sure the CD is still in the CD or DVD drive.

Open the Writing Trek folder on your hard disk.

Double-click The Writing Trek 8-10 I icon to open the program.

Learning more about The Writing Trek

For an introduction to the program, double-click The Guided Tour icon in the
CD window.

A teacher’s guide is included on The Writing Trek CD. Double-click the Teacher’s
Guide 8-10.pdf icon to open the teacher’s guide.

The Writing Trek also includes an electronic help system. Click the character at the
top-left corner of most screens to hear more information about the elements of
that screen.

The service and support telephone number for The Writing Trek is 800-321-7511.
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